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Where To Find Information

To set up your EPSON Stylus CX3200 and install its software, see the Start Here 
sheet and Macintosh Software Installation booklet. This User’s Guide contains 
instructions on copying, printing, scanning, maintenance, troubleshooting, network 
printing, and specifications. 

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your EPSON Stylus CX3200.

Tips contain hints for better copying, scanning, and printing.

Loading Paper

� Single Sheets

� Envelopes

� Special Papers

Single Sheets

1. Make sure your EPSON Stylus CX3200 and computer are turned on. 

2. Flip the feeder guard forward.

3. Insert your paper against the right edge of the sheet feeder, beneath the tab.

4. Pinch the left edge guide and slide it against the paper (but not too tightly).

5. Flip the feeder guard back over the paper.

Note: Make sure you didn’t insert the paper in front of the feeder guard.
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6. Open the output tray and its extension.

Also be sure to:

� Load the printable side face-up. It’s often whiter or brighter than the other side.

� Load letterhead or preprinted paper into the Stylus CX3200 top edge first.

� Don’t load paper above the tab or arrow on the left edge guide.

� Load up to approximately 50 sheets of plain paper at a time.

If you’re loading envelopes or special paper, see the next sections.

Envelopes

You can load up to 10 envelopes at a time, flap edge left, and printable side up. 

Slide the left edge 
guide against the 
paper, but not too 
tightly

Insert paper against 
the right edge

Open the output tray 
and extension

Flip the feeder 
guard back over 
the paper
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Place them against the right edge of the sheet feeder, then pinch the left edge guide 
and slide it against the envelopes (but not too tightly).

Note: For best results, press each envelope flat before loading, or load one 
envelope at a time.

Select the following settings when printing on envelopes:

� Plain paper as the Type or Media Type setting

� The correct envelope size as the Size (Windows) or Paper Size (Macintosh) setting

� Landscape as the Orientation setting

For instructions on selecting these settings, see:

� Printing From an Application (Windows)

� Printing With Macintosh OS 8.6 to 9.x

� Printing With Macintosh OS X

Load envelopes 
printable side up, and 
flap edge left
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Special Papers

EPSON offers the following special ink jet papers for the EPSON Stylus CX3200:

Paper name* Size Part number

EPSON Premium Bright White Paper Letter (8.5 x 11 inches) S041586

EPSON Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

EPSON Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

EPSON Photo Paper or EPSON 
Glossy Photo Paper

4 x 6 inches, with 
perforated edges

S041134/S041671

4 x 6 inches, 
non-perforated, 
borderless

S041458

Letter (8.5 x 11 inches) S041141/S041272/
S041271/S041272

A4 (8.3 x 11.7 inches) S041140

Panoramic (8.3 x 23 
inches)

S041145

EPSON Matte Paper Heavyweight Letter (8.5 x 11 inches) S041257

8 x 10 inches, borderless S041467

EPSON Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

EPSON All Purpose Glossy Paper Letter (8.5 x 11 inches) S041654

EPSON Premium Glossy Photo 
Paper

Letter (8.5 x 11 inches) S041286/S041667

4 x 6 inches, borderless S041682

5 x 7 inches, borderless S041464

8 x 10 inches, borderless S041465

EPSON Premium Semigloss Photo 
Paper

Letter (8.5 x 11 inches) S041331

EPSON Ink Jet Transparencies Letter (8.5 x 11 inches) S041064
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* The availability of paper types varies by location.

To order EPSON ink cartridges, paper, and other printing media, contact your dealer 
or call EPSON at (800) 873-7766 or visit the EPSON Store  at 
www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for 
dealer referral.

To load EPSON special ink jet papers, follow these guidelines:

EPSON Photo Quality Self Adhesive 
Sheets

A4 (8.3 x 11.7 inches) S041106

EPSON Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153/S041155

EPSON Photo Stickers Kit 
(CD-ROM/stickers)

EPSON Photo Stickers (refill)

A6 (4.1 x 5.8 inches)

A6 (4.1 x 5.8 inches)

S041144-KIT

S041144

EPSON Glossy Photo Greeting Cards Letter (8.5 x 11 inches); 
perforated edges

S041606

Paper type Loading capacity

Glossy Photo Paper or Photo Paper

All Purpose Glossy Paper

20 sheets with a support sheet beneath the stack

Photo Quality Ink Jet Paper 30 sheets, or up to 10 sheets of legal-size paper

Premium Glossy Photo Paper

Premium Semigloss Photo Paper

1 sheet, or up to 20 sheets of 5 × 7-inch paper

Premium Bright White Paper 40 sheets

Matte Paper Heavyweight 20 sheets with a support sheet beneath the stack

Photo Quality Self Adhesive Sheets

Iron-On Transfer Paper

Glossy Photo Greeting Cards

1 sheet

Photo Quality Ink Jet Cards 30 cards with a support sheet under the stack

Paper name* Size Part number

SM
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� Load all paper with the printable side up. It’s usually whiter or brighter than the 
other side.

� If the paper has a cut corner, position it in the upper right corner as you load it in 
the sheet feeder.

� Check the paper package for additional instructions on using special papers.

Photo Stickers

Panoramic Photo Paper

Double-Sided Matte Paper

1 sheet with a support sheet beneath the sheet

Ink Jet Transparencies 10 sheets with support sheet beneath the stack
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Stand-alone Copying

� Basic Copying

� Changing Copy Settings

Basic Copying

1. Open the scanner lid.

2. Place your document face-down on the glass, in the corner shown below. Move 
your document about 0.1 inch from the top and side edge so your entire 
document is scanned.

3. Close the scanner lid.

4. The default copy settings are displayed on the control panel. Change any 
necessary copy settings, as described in Changing Copy Settings.

5. Press the Color Copy button (for color copies) or B&W Copy button (for black 
and white copies). Your document is scanned and then printed. If you’re using the 
2-up Copy Mode setting (see Type of Copies), repeat these steps for your second 
page.

Note: Your copied image size may not be the exact same size as your original.

Move the document 
in about 0.1 inch from 
the edges
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Changing Copy Settings

The current copy settings are shown on the LCD screen. You can change copy 
settings using the control panel, as described below.

 

When you finish changing a setting, press the Stop button.

Note: To clear a setting, press the Reset button. To clear all the setting changes 
you’ve made, press and hold the Reset button for at least 3 seconds. 

If you’ll be changing the Copy mode setting (as described in Type of Copies), 
select your Copy mode before selecting any other copy settings.

Number of Copies

Press the + or - Copies buttons. (If you’re using the 2-up Copy Mode setting (see 
Type of Copies), you can’t select the number of copies.)

Paper Size

Press a Menu button until you see Paper size on the LCD screen. Then press the 
+ or - Value buttons to select the size of the paper you loaded, either Letter, 4 × 6, 
5 × 7, or A4 (8.3 × 11.7 inches).

Lighten or Darken

Press a Menu button until you see Lighter/Darker on the LCD screen. Then press 
the + or - Value buttons to lighten or darken your copies.

Current settings are shown here

Menu 
buttons

Copies/Value buttons
(+ and -)

Stop 
button

Reset 
button
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Type of Copies

Press a Menu button until you see Copy mode on the LCD screen. Then press the 
+ or - Value buttons to select one of these copy modes:

Copy mode Results

Standard Margins

Exact copies of your original with 
an 0.55-inch margin at the bottom 
of the page

Border Free

Copies sized as necessary to fit to 
the edges of your paper*

Small Margins

Copies with only an 0.05-inch 
border around the edges*

Mirror

Copies inverted horizontally for 
printing on transfer paper

Repeat

Copies an image multiple times on 
one sheet 
(Works best with originals that are 
business-card-size or smaller)

2-up

Two originals copied onto one 
sheet

5 5

5
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* If you notice reduced print quality at the bottom of your copy, try using the Standard Margins 
setting.

Note: The Copy mode settings determine the options available with other 
settings on the control panel. Not all of the other options described here are 
available with every Copy mode setting.

Copy Quality

Press a Menu button until you see Quality&Paper on the LCD screen. Then press 
the + or - Value buttons to select a print quality appropriate for your document and 
the paper you loaded:

Minimize Margins

Copies with only an 0.1-inch border 
around the edges*

Quality&Paper setting Use when you’ve loaded. . .

Plain Paper–Econ Plain paper or Premium Bright White Paper for quick 
copying with draft print quality

Plain Paper–Norm Plain paper or Premium Bright White Paper for text copying 
with normal print quality

Plain Paper–Fine Plain paper or Premium Bright White Paper for text and 
graphics copying with high print quality

PQIJ Paper–Fine Photo Quality Ink Jet Paper, Cards, or Self-Adhesive sheets 
for copying with high print quality (also for Plain paper or 
Premium Bright White Paper for improved image quality)

PQIJ Paper–Photo Photo Quality Ink Jet Paper, Cards, or Self-Adhesive sheets 
for copying with photo print quality (also for Plain paper or 
Premium Bright White Paper for improved image quality)

Photo Paper Photo Paper, Glossy Photo Paper, Photo Quality Glossy 
Paper, Glossy Photo Greeting Cards, or All Purpose Glossy 
Paper

Premium Glossy Premium Glossy Photo Paper

Copy mode Results
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Note: Not all of these settings may be available, depending on the current Copy 

mode setting.

Reduce or Enlarge

Press a Menu button until you see Reduce/Enlarge on the LCD screen. Then press 
the + or - Value buttons to enlarge or reduce your document to fit on the paper you 
loaded. Or select Auto Fit Page to have the EPSON Stylus CX3200 automatically 
determine the necessary reduction or enlargement.

To reduce or enlarge by a precise percentage, press a Menu button until you see 
Zoom In/Out on the LCD screen. Then press the + or - Value buttons to select a 
percentage of the scanned image for the resulting print. 

Note: If you select Auto Fit Page as the Reduce/Enlarge setting to copy a 
document with white or very light colored edges, the original size may not be 
recognized correctly, creating an incorrect size copy. If this occurs, select 100% 

as the Reduce/Enlarge setting and use the Zoom In/Out setting to adjust the size 
of your copy.

Copying With the Computer

Follow these steps to use EPSON Smart Panel to copy from your computer (not 
available with Mac OS X):

1. Make sure the EPSON Stylus CX3200 is on and paper is loaded in the sheet 
feeder. 

2. Place the document face-down on the glass, in the top, left corner as described in 
Placing Your Original Document.

3. Select the EPSON Smart Panel icon on your desktop. Or with Windows, 
click Start > All Programs or Programs > EPSON Smart Panel > EPSON 
Smart Panel.

Matt Paper HW Matte Paper Heavyweight or Double-Sided Matte Paper

Quality&Paper setting Use when you’ve loaded. . .
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You can also press the Scan button on the EPSON Stylus CX3200 control panel 
to open Smart Panel. (To change the application assigned to the Scan button, see 
One-Touch Scanning.)

Note: On a Macintosh, you can also open EPSON Smart Panel by selecting 
Applications > EPSON > Smart Panel > EPSON Smart Panel.

4. Click the Smart Panel Copy button. You see the Copy Settings screen.

5. Adjust any of the following copy settings:

� Source Type: Choose Photo & Text, Photo, or Text, based on the content of 
your original.

� Size: Choose the setting based on the size of your original and your copy, or 
click Manual and enter a percentage to reduce or enlarge your copy by a 
specific amount. 

� Lighten/Darken: Adjust this by clicking the up and down arrows.

� Number of Copies: Enter a number or click the up and down arrows.

Note: Press the Cancel button if you need to cancel any setting changes you 
made.

Copy button

Stop button

Cancel button
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6. Click the Device Settings button on the right to check your input and output 
devices:

You should see your EPSON Stylus CX3200 as the output device and EPSON 
TWAIN 5 (your scanning software) as the input device. 

Click Settings to change the displayed print settings (such as a different Media 
Type setting, if you loaded special paper) or select additional options. See these 
sections for details:

� Basic Windows Printing

� Printing With Macintosh OS 8.6 to 9.x
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7. Click the Image Adjust button on the right to enhance your image or add 
effects:

� Enable or disable the automatic document enhancement feature

� Add a sepia, blue, or black and white filter

� Adjust brightness, contrast, or saturation levels

8. Click the Copy button to start copying. 

If you need to stop copying in progress, click the Stop button.

Note: For more information on Smart Panel copy settings, see the on-screen 
Smart Panel User Guide or click ? on the main Smart Panel window.
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Basic Windows Printing

� Printing From an Application

� Selecting Default Settings

Printing From an Application

After you create a document in a software program, follow these steps to print it using 
the basic printer settings: 

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus CX3200 is selected.

3. Click the Preferences or Properties button.

(If you see a Setup, Printer, or Options button, click it. Then click Preferences 
or Properties on the next screen.)

Click here to open your 
printer software

Check for your printer name
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4. Select the following settings on the Main tab in your printer settings window: 

Tip: For more information about printer settings, click the ? or Help button.

5. You return to the Print window. Click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You 
can use the buttons to cancel, pause, or resume printing. You can also see how much 
ink you have left. 

2 Select your paper 
type (see Selecting 
Your Media Type)

5 Click OK

Draft: for rough drafts with 
reduced print quality

Text: For text-only 
documents (like letters) with 
good print quality

Text & Image: For 
documents with text and 
images with higher print 
quality

Photo: For photos and 
graphics with good print 
quality and speed

Best Photo: For photos or 
graphics with high print 
quality

3 Select your paper 
size

4 Select your 
document or image 
orientation

1 Select the type of document you’re printing:

Click to cancel printing

Click to pause or 
resume printing
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Selecting Default Settings

Your printer settings apply only to the program you’re currently using. If you want, 
you can change the Windows default printer settings for all your programs.

1. Right-click the  printer icon in the lower right corner of your screen (taskbar). 

2. Select Printer Settings. You see the window shown in Printing From an 
Application.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Customizing Windows Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the 
window. The Basic settings change to the Advanced settings.

2. Select the following advanced settings as necessary:

1 Select Paper & Quality 
options as necessary

Click here to select 
Photo RPM for the best 
print quality on photo and 
glossy paper types

2 Select Print Options as 
necessary

Click here to select Black 

Ink Only printing

3 Select a color 
management method 

To choose No Color 

Adjustment, click ICM first
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3. Once you’ve finished selecting advanced settings, you can: 

� Click OK to save your settings, return to the Print dialog box, and print.

� Click the Basic button to return to the Basic settings.

� Click the Page Layout tab and continue with step 4 to select layout options.

Note: For more information about advanced settings, or instructions on saving 
them as a group so you can reuse them later, click the Help or button. If you 
want to use the Advanced screen each time you access your printer settings, 
select the Show this screen first checkbox.

4. Select the following page layout settings as necessary:

Note: For more information on page layout settings, click the Help or ? button.

5. Click OK to save your settings, return to the Print dialog box, and print.

1 Select image or 
document position 
options here

2 Select image or 
document resizing 
options here; these 
affect only your printed 
image

3 Add a watermark to 
your printed page here

4 Select multi-page 
document options 
here and here

To print a large image 
on several sheets to 
make a poster, select 
settings here
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Printing With Macintosh OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described in 
the Macintosh Software Installation booklet.

1. From the File menu, select Page Setup. Select the following settings:

2. Click OK to close the Page Setup window.

3. From the File menu, select Print. Select the following settings:

Tip: For more information about printer settings, click the ? button.

4. You can also do the following:

� Click  to reduce/enlarge your printed image, print multi-page layouts, or 
add a watermark.

� Click  to control background printing and schedule print jobs. 

1 Make sure you see CX3200

2 Select your paper size

3 Select the orientation of your 
document or image

4 Select Quality, Speed, 
or an in-between setting

1 Select your paper type 
(see Selecting Your 
Media Type)

3 Select Automatic mode

2 Select Color (for color 
documents and black and 
white photographs) or 
Black (for black text 
documents)
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� Click , then click Preview to preview your printout.

� Click  to check your ink levels. 

5. Click Print. 

6. If you turned on background printing, you can select EPSON Monitor IV from 
the Application menu in the upper right corner of the screen. You see the EPSON 
Monitor window:

Note: If you’re not using background printing and you need to cancel printing, 
hold down the key and press the . (period) key.

Printing With Macintosh OS X

If you’re using an OS X compatible printing application, follow the steps below to 
print a document. (If you’re using an application that’s compatible only with 
Macintosh Classic mode, follow the steps in Printing With Macintosh OS 8.6 to 9.x 
instead.)

Before you begin, make sure you added your printer to Print Center as described in 
the Macintosh Software Installation booklet.

1. From the File menu, select Page Setup.

Select your print job, 
then click here to 
cancel printing

Click to check 
ink levels
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2. Select the following Page Setup settings as necessary:

3. When you’re finished, click OK.

4. Select Print from the File menu. You see a screen like this:

5. Select Print Settings from the pull-down menu.

Select CX3200 from 
the Format for 
pop-up menu

Select the Paper Size, 
Orientation, and any 
other settings you 
want to use

Click here and 
select Print 

Settings 
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6. Select the following Print Settings as necessary:

Tip: For more information about printer settings, click Help. The OS X printer 
driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh 
printer driver described in this book.

7. You can also choose other print settings by selecting these options in the 
pull-down menu:

� Copies & Pages, to select the number of copies or a page range

� Layout, to select page layout options

� Output Options, to save your print job as a PDF file

� Color Management, to select ColorSync,® adjust the color controls, change 
the gamma setting, or turn off color adjustments by the printer software

� Summary, to view a list of all your selections

� Save Custom Setting, to save your selections for future use.

8. Click Print.

4 Select Quality, Speed, 
or an in-between setting

1 Select your paper type 
(see Selecting Your 
Media Type)

3 Select Automatic mode

2 Select Color (for color 
documents and black and 
white photographs) or 
Black for black text 
documents
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9. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock on the bottom of your desktop. You see a screen like this:

10. Monitor the progress of your print job or do one of the following:

� Click the print job, then click Delete to delete the job

� Click the print job, then click Hold to pause printing

� Click a print job marked “Hold” and click Resume to resume printing

� If multiple print jobs are listed, click a print job, then click the Priority arrow 
as necessary to reorder the jobs

11. When you’re finished, close Print Center.
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Customizing Macintosh Print Settings

You can use advanced settings for color matching, printing at a higher resolution, or 
selecting a variety of special effects and layouts.

1. On the printer settings window, click Custom, then click the Custom Settings 
list to open it. 

Note: For more information on custom settings, click Help (OS X) or ? 
(OS 8.6 to 9.x).

2. If you’re finished selecting custom settings, click Print to print your document.

To select more custom settings, go to step 3.

3. To access advanced settings, click Custom, then click Advanced (OS 8.6 to 9.x) 
or click Advanced Settings (OS X).

Macintosh OS 8.6 

to 9.x

Macintosh OS X

Click Custom, then choose:
Text/Graph (for text, charts, or graphs)
Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the 
Custom Settings list

Click Custom, then choose:
Text/Graph (for text, charts, or graphs)
Economy (to save ink on plain paper) or 
ColorSync (to match printed colors with 
compatible device colors) from the 
Custom Settings list
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4. Select these advanced settings as necessary:

Note: For more information on advanced settings, or instructions on saving them 
as a group so you can reuse them later, click Help (OS X) or ? (OS 8.6 to 9.x).

5. OS 8.6 to 9.x: Click OK to save your settings, then click Print.

OS X: Click Print.

3 Select color management 
settings here

1 Click here to select 
Photo RPM for the best print 
quality on certain paper types

2 Select various print 
options here

Macintosh OS 8.6 through 9.x

2 Select various print options here

3 To select color management 
settings, select Color Management 
from the Print Settings pull-down 
menu

Macintosh OS X

1 Click here to select Photo RPM 
for the best print quality on photo 
and glossy paper types
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Selecting Your Media Type

Select the correct Type or Media Type setting so your printer knows what kind of 
paper you’re using and adjusts the ink coverage accordingly.

For this paper . . .

Select this Type or Media Type 

setting . . .

Plain paper sheets or envelopes Plain paper

EPSON Premium Bright White Paper Bright White Paper

EPSON Iron-On Transfer Paper 360 dpi Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards

EPSON Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

EPSON Matte Paper Heavyweight

EPSON Double-Sided Matte Paper

Matte Paper - Heavyweight

EPSON Photo Paper

EPSON Glossy Photo Paper

EPSON All Purpose Glossy Paper

EPSON Photo Quality Glossy Paper

EPSON Glossy Photo Greeting Cards

Glossy Photo Paper

EPSON Premium Glossy Photo Paper

EPSON Premium Semigloss Photo Paper

Premium Glossy Photo Paper

EPSON Photo Stickers® Photo Quality Glossy Film

EPSON Ink Jet Transparencies Ink Jet Transparencies
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Printing BorderFree Photos

� BorderFree Papers

� Using Printer Software

BorderFree Papers

You can print your photos with no margins, extending the image all the way to the 
edges of the page. Although BorderFree printing is a bit slower (especially near the 
edges), you get beautiful snapshots or enlargements, without trimming. 

BorderFree printing supports the following paper types and sizes: 

EPSON paper name Sizes

Type or Media Type 

setting

Photo Paper or Glossy Photo Paper Letter-size

4 × 6 (with or 
without perforated 
edges)

A4 (8.3 × 11.7 
inches)

Panoramic

Glossy Photo Paper

All Purpose Glossy Paper Letter-size

Glossy Photo Greeting Cards 8 × 10 (with 
perforated edges)

Premium Glossy Photo Paper Letter-size

8 × 10

5 × 7

4 × 6

Premium Glossy Photo 
Paper

Premium Semigloss Photo Paper Letter-size

Matte Paper Heavyweight Letter-size

8 × 10

Matte Paper - 
Heavyweight
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Note: For instructions on loading special paper, see Special Papers.

You can print BorderFree photos using your EPSON Stylus CX3200 control panel or 
your printer software. 

To use the control panel, follow the instructions in Stand-alone Copying and select 
Border Free as the Copy Mode setting, as described in Type of Copies.

To use your printer software, follow the instructions in the next section.

Using Printer Software

Follow the steps for your operating system below to print BorderFree photos using 
your printer software.

Windows

1. Start your printing application and open your photo file.

2. Access the printer settings window (see Basic Windows Printing).

3. Select Photo or Best Photo as the Quality Type setting.

4. Select your paper type as the Type setting. See BorderFree Papers.

Photo Quality Ink Jet Paper A4 Available for stand-alone 
copying only; see 
Stand-alone Copying

EPSON paper name Sizes

Type or Media Type 

setting
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5. Click the Borderless checkbox, then select your paper size as the Size setting.

6. Select Portrait or Landscape as the Orientation setting.

7. Click OK.

8. Click OK or Print.

Macintosh

Note: BorderFree printing is not available with Macintosh OSX.

1. Start your printing application and open your photo file.

2. Click File > Page Setup. 

3. Click the Borderless checkbox, then select your paper size as the Paper Size 
setting.
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4. Select Portrait or Landscape as the Orientation setting.

5. Click OK.

6. Click File > Print.

7. Select your paper type as the Media Type setting. See BorderFree Papers.

8. Click Print.

Printing With Exif Print

If your digital camera supports Exif Print, you can use this technology when you print 
with the EPSON Software Film Factory program that came on your Stylus CX3200 
CD-ROM to ensure the most accurate image reproduction (Exif Print is not available 
with Macintosh OS X).

Follow the instructions in the Film Factory Getting Started Guide (installed with the 
program) to print Exif Print photos.
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Basic Scanning

� Placing Your Original Document

� Using EPSON Smart Panel

� Scanning to a File

� One-Touch Scanning

Placing Your Original Document

1. Open the scanner lid.

2. Place your document face-down on the glass, in the corner shown below. Move 
your document about 0.1 inch from the top and side edge so your entire 
document is scanned.

3. Close the scanner lid.

Note: If you place your document against the guides, the edges next to the 
guides won’t be scanned.

If you need to scan a thick document, such as a book, you can remove the 
scanner lid to scan. Gently press down the original to keep it flat on the document 
table. Be sure to replace the scanner lid when you’re finished.

Move the document 
in about 0.1 inch 
from the edges
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Using EPSON Smart Panel

EPSON Smart Panel is an easy, step-by-step interface for scanning, copying, printing, 
and more. You can use it to launch a variety of programs on your computer, as 
described below, or use it with the EPSON Stylus CX3200 Scan button for 
automatic scanning and copying, as described in One-Touch Scanning.

Smart Panel features Description

Scan to Web

Scans an image and uploads it to EPSON’s photo-sharing 
web site.

Photo Print

Scans and prints photos in various sizes and layouts.

Scan for Creativity

Scans a photo into ArcSoft PhotoImpression where you can 
edit, retouch, enhance, and print it with templates, frames, 
and borders.

Scan to File

Scan an image or document directly to a file on your hard 
drive.
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For details on using all the Smart Panel features, click the ? button in Smart Panel or 
see the on-screen Smart Panel User Guide.

Scanning to a File

You can quickly scan an image or document directly to a file on your hard drive.

Using EPSON Smart Panel (Windows and Mac OS 8.6 to 
9.x)

Smart Panel is a simple way to scan directly to a file in just a few steps.

1. Place the document face-down on the glass, in the top, left corner as described in 
Placing Your Original Document.

Copy

Scans and prints an image or document with the power and 
flexibility of a conventional photocopier.

Scan to OCR

Scans text documents and converts them into editable text 
files on your computer with great accuracy.

Scan to E-mail

Scans an image or document and attaches it to an e-mail so 
you can send it right away.

Scan to Application

Scans and image or document and lets you choose which 
program it launches for handling the scanned file.

Copy to Fax

When you install your own fax software, scans your image or 
document and faxes it to your chosen destination.

Smart Panel features Description
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2. Select the EPSON Smart Panel icon on your desktop. Or with Windows, 
click Start > All Programs or Programs > EPSON Smart Panel > EPSON 
Smart Panel.

You can also press the Scan button on the EPSON Stylus CX3200 control panel 
to open Smart Panel. (To change the application assigned to the Scan button, see 
One-Touch Scanning.)

Note: On a Macintosh, you can also open EPSON Smart Panel by selecting 
Applications > EPSON > Smart Panel > EPSON Smart Panel.

3. Click the Scan to File button. Smart Panel starts EPSON TWAIN, which 
automatically scans your document.
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4. In the following screen, double-click a photo to see an enlarged preview and make 
sure it scanned properly. To rename the image, click the file name below it and 
type in a new name.

5. Click Finish. (Or click Scan More to scan additional images.)

6. Select a folder and file format, then click Save to save your file to the location you 
selected. It’s ready to open in a compatible image editing program, print, e-mail, 
or use as you like.

Note: For instructions on scanning with the other Smart Panel options, select 
Help in the Smart Panel window or open the User Guide in the EPSON Smart 
Panel program group.

Click here 
to rename 
file
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Using EPSON Scan to File in Mac OS X

EPSON Scan to File launches EPSON TWAIN and saves the scanned images to files 
automatically. It generates sequential file names so you can quickly scan an image 
with different TWAIN settings and select the one you like the most.

1. Place the document face-down on the glass, in the top, left corner as described in 
Placing Your Original Document.

2. Open your OS X Applications folder, then open the EPSON Scan to File 
folder.

3. Double-click the EPSON Scan to File icon. You see the File Save Settings 
screen:

4. The images you scan are saved to the folder listed in the Location box. To change 
the folder, click the Choose button and select the folder you want.

5. The files are named with the prefix img. To change the prefix, enter a different 
three-character name in the Prefix box.

6. The files are saved in the TIFF (*.tif) file format. You can select the JPEG, 
Multi-TIFF, or PICT format from the Type drop-down menu instead.

Note: For details on the available settings, click the Help button.
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7. Open the File menu and click Select Scanner. You see this window:

8. Select EPSON TWAIN 5 and click Select. (You only need to perform steps 6 
and 7 the first time you run EPSON Scan to File.)

9. Make sure your image is placed on the document table and the scanner lid is 
closed.

10. Click Next on the File Save Settings screen. After a moment, you see this screen:

11. EPSON TWAIN begins scanning your image in Full Auto Mode. Wait for 
scanning to finish.

To stop the scan and select settings in manual mode, click Cancel. Then click the 
Manual mode button on the next screen. You see the EPSON TWAIN settings 
dialog box.

Note: For detailed information on EPSON TWAIN settings, see Advanced 
Scanning or click the Help button.

12. When scanning finishes, EPSON Scan to File saves your file to the location you 
selected. It’s ready to open in a compatible image editing program, print, e-mail, 
or use as you like.
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One-Touch Scanning

You can use your Scan button to automatically scan a photo into an imaging 
application, scan a document to convert it into editable text, or scan to e-mail, print, 
or fax. (Not available with Macintosh OS X.)

The following example explains how to set up the Scan button so you can scan files 
to e-mail. 

1. Place the document face-down on the glass, in the top, left corner as described in 
Placing Your Original Document.

2. Select the EPSON Smart Panel icon on your desktop. Or click Start > All 
Programs or Programs > EPSON Smart Panel > EPSON Smart Panel.

Note: On a Macintosh, you can also open EPSON Smart Panel by selecting 
Applications > EPSON > Smart Panel > EPSON Smart Panel.

3. Select Scan to E-mail in the Scan button start list in the bottom left corner of the 
Smart Panel window. Then exit Smart Panel.

4. Press the Scan button on the EPSON Stylus CX3200 control panel.

Scan button 
start list



39

5. Smart Panel starts and EPSON TWAIN automatically scans your document.

6. On the next screen, double-click your document thumbnail to enlarge the 
preview and make sure it scanned properly. To rename the image, click the file 
name below it, type in a new name, and click OK. Then click Finish.

7. On the next screen, select your e-mail program and click the Launch button. 
Your document is automatically attached to a blank e-mail.

Note: If your e-mail program isn’t listed, click the Help button for instructions on 
adding your e-mail program to the list. For a list of supported programs, see your 
on-screen Smart Panel User Guide.

8. Complete your e-mail by entering the address and subject, and adding a message, 
if you like. Then send your e-mail.
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9. To continue one-touch scanning to e-mail, just press the Scan button and repeat 
steps 6 through 9. To change the program that opens when you press the Scan 
button, select a different option in the Scan button start list on the Smart Panel 
window, as described in step 4.

Advanced Scanning

You can use advanced scanning features from within a TWAIN-compliant host 
application, such as Adobe® Photoshop® or EPSON Smart Panel. You have to start 
this application to select and access EPSON TWAIN, as described below (the steps 
may vary, depending on your application). 

1. Place the document face-down on the glass, in the top, left corner as described in 
Placing Your Original Document.

2. Start your application.

3. Windows: Select the scanner source. Open the File menu and choose Select 
Source, Import, or Acquire.

Macintosh OS 8.6 to 9.x and OS X: Go to step 4.

4. Windows: Select EPSON TWAIN 5 and click Select or OK.

Note: If your computer fails to recognize the EPSON Stylus CX3200, you won’t 
see EPSON TWAIN 5 when you try to select a scanner source from your host 
application. In addition, an error message may appear. If this happens, turn off 
your computer and the Stylus CX3200, then turn the Stylus CX3200 back on and 
restart your computer.

Click to select the 
scanner source
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5. Start EPSON TWAIN for scanning. Open the File menu and choose Import or 
Acquire and if necessary, select TWAIN_32 (Windows) or EPSON TWAIN 5 
(Macintosh).

6. Click Cancel when you see the following screen.

7. On the next screen, click the Manual mode button.

Click to open 
EPSON TWAIN

Click Cancel

Click Manual mode
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You see the EPSON TWAIN settings dialog box:

8. Make sure the Image Type, Destination, and Resolution settings are correct 
for the type of image you’re scanning and the way you’ll be printing or viewing it.

9. Click the Preview button to preview your scanned image.

10. Click the Auto Locate button to place a border (or marquee) around your 
image so only your image is scanned. You can adjust the border as necessary.

11. Click the Auto Exposure button to have TWAIN automatically adjust the 
exposure settings for your image.

12. Make any other changes you want, then click the Scan button. Your image is 
automatically scanned and optimized.

Note: For detailed information on EPSON TWAIN settings, click the Help button.

13. If you want to switch back to Full Auto mode, click the Full Auto mode button.

14. Click Close to close the EPSON TWAIN 5 window and return to your scanning 
application screen. Your scanned image appears on the screen so you can modify 
it, save it, print it, or use it as you like.

Check your 
Image Type, 
Destination, and 
Resolution 
settings

Click to return 
to Full Auto 
mode

Preview 
your scan 
here

Click to 
preview your 
scan

Click to automatically mark the 
border of the image for scanning

Click to automatically set the 
exposure

Click to scan
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Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to 
clean the print head. This unclogs the nozzles so they can deliver ink properly. Print 
head cleaning uses ink, so clean it only if quality declines. 

Note: You can also use a printer software utility to clean the print head right from 
your computer. Select the ? or Help button on your printer settings window for 
instructions running the print head cleaning utility.

1. Make sure the EPSON Stylus CX3200 is turned on but not printing, and the 
Error light is off. (If the Error light is flashing or on, you may need to replace an 
ink cartridge; see Replacing an Ink Cartridge for details.)

2. Press a Menu button until you see Head Cleaning on the LCD screen.

3. Press the Color Copy button.

Cleaning takes about 30 seconds, during which the Stylus CX3200 makes some 
noise and the On light flashes briefly.

Caution: Never turn off the EPSON Stylus CX3200 while the On light is flashing, 
unless the Stylus CX3200 hasn’t moved or made noise for more than 5 minutes.

4. When the On light stops flashing, run a nozzle check to confirm the print head 
nozzles are clean. 

Make sure paper is loaded, press a Menu button until you see Nozzle Check on 
the LCD screen, and press the Color Copy button. The nozzle check pattern 
prints. 

On light Error light Color Copy button

Menu buttons
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Note: You can also use a printer software utility to print a nozzle check right from 
your computer. Select the ? or Help button on your printer settings window for 
instructions running the nozzle check utility.

5. Examine the nozzle check pattern you print. It should look something like this:

Each staggered line should be complete, with no gaps in the dot pattern. If your 
printout looks okay, you’re done. 

If you see any gaps in the dot pattern, clean the print head again. 

6. When you’re finished, press the Stop button.

If you don’t see any improvement after cleaning three or four times, check the 
solutions in Problems and Solutions. You can also turn the EPSON Stylus CX3200 
off and wait overnight—this allows any dried ink to soften—and then try cleaning the 
print head again.

Caution: When you don’t turn on your EPSON Stylus CX3200 for a long time, the 
print quality can decline. It’s a good idea to turn on your EPSON Stylus CX3200 at 
least once a month to maintain good print quality.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the 
expiration date on the package:

� Black ink cartridge: T040120

� Color ink cartridge: T041020

Caution: To ensure good results, use genuine EPSON ink cartridges and do not 
refill them. Other products may cause damage to your EPSON Stylus CX3200 not 
covered by EPSON’s warranty.
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When you need new ink cartridges, contact your dealer, or call the EPSON Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral. 

Replacing an Ink Cartridge

� Checking the Ink Supply

� Ink Cartridge Precautions

� Removing and Installing Ink Cartridges

Checking the Ink Supply 

If the Error light on the EPSON Stylus CX3200 is flashing and you see an ink low or 
ink out message on the LCD screen and your computer monitor, you need to replace 
one of the cartridges.

When a cartridge is more than six months old, you may need to replace it if printouts 
don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge.

To check your ink supply, do one of the following:

� Press a Menu button on the control panel until you see Ink Levels. This gives 
you an approximate percentage of ink remaining in each cartridge. You can also 
check the icon on the LCD screen to see an approximate indication of the ink 
level.

� Windows: Double-click the  printer icon in the lower right corner of your 
screen. If a cartridge is low on ink, you’ll see a message in the window that appears 
on your screen.

Menu buttons
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� Macintosh: 

OS 8.6 to 9.x: Choose File > Print. Click the ink icon.

OS X: Choose Applications > EPSON Printer Utility > CX3200 > Status 
Monitor.

You see a window like this:

Click a cartridge image to display information about the cartridge.

Ink Cartridge Precautions

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the EPSON Stylus CX3200, never move the print 
head by hand.

You cannot print if either ink cartridge is empty. Leave the empty cartridge 
installed in the EPSON Stylus CX3200 until you have obtained a replacement. 
Otherwise the ink remaining in the print head nozzles may dry out.
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Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink 
cartridge replacement procedure, you must complete all the steps in one session. 

1. Make sure the EPSON Stylus CX3200 is turned on and not printing. The control 
panel tells you which ink cartridge is low or empty. 

2. Press a Menu button until you see Change Cartridge, then press the Color 
Copy button. The ink cartridges move to the replacement position.

3. Lift up the scanner.

Menu buttons Color Copy button
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4. Pull up the ink cartridge clamp. (The color cartridge is on the right and the black 
is on the left.)

5. Lift the cartridge out of the EPSON Stylus CX3200 and dispose of it carefully.

6. Unwrap the new ink cartridge. Then remove only the yellow tape seal on top. 

Caution: You must remove the yellow tape from the top of the cartridge or you 
will permanently damage it. 

Don’t touch the green circuit board on the back of the cartridge; you may inhibit 
normal operation and printing. 

Black cartridge Color cartridge
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7. Lower the new cartridge into its holder and rest the tabs on the hooks in the back.

Caution: Don’t place the cartridge under the hooks; you may damage the clamp 
when you close it. 

8. Press down firmly on the ink cartridge clamp until it snaps in place.

If you need to replace the other ink cartridge, repeat steps 4 through 8 before 
continuing with step 9.

9. Carefully lower the scanner and press it down until it clicks into place. The 
EPSON Stylus CX3200 begins charging the ink delivery system.

The On light flashes and the EPSON Stylus CX3200 makes noise. Charging takes 
about 30 seconds. When it’s finished, the On light stops flashing and stays on. 

Caution: Never turn off the EPSON Stylus CX3200 while the On light is flashing, 
unless the Stylus CX3200 hasn’t moved or made noise for more than 5 minutes. 

Hooks
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may need to align the print 
head. 

Note: You can also use a printer software utility to align the print head right from 
your computer. Select the ? or Help button on your printer settings window for 
instructions running the print head alignment utility.

1. Make sure the EPSON Stylus CX3200 is turned on and not printing, and the 
Error light is off.

2. Load plain, letter-size paper in the sheet feeder.

3. Press a Menu button until you see Head Alignment, then press the Color Copy 
button to print an alignment page.

4. On the test page, select the pattern with the two vertical lines most precisely 
printed on top of each other. You may need to use a magnifying glass or loupe.

Select one pattern each for rows 1, 2, and 3. (In this example, pattern 8 is the best 
in each row.)

5. Press the + or - Value buttons to select the number of the best pattern for the first 
row, then press the Color Copy button. Repeat this step for the second and third 
rows.

Note: If you select a pattern other than 8 in any row, that pattern becomes 
pattern #8 the next time you align the print head.

6. When you’re finished, press the Stop button.
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Cleaning the EPSON Stylus CX3200

To keep your EPSON Stylus CX3200 operating at its best, you should clean it 
periodically.

1. Turn off the EPSON Stylus CX3200, unplug the power cord, and disconnect the 
USB cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior with a soft, damp cloth. (Keep the scanner and scanner lid 
closed as you clean.)

4. If necessary, lift up the scanner and clean ink out of the interior with a soft, damp 
cloth. 

5. Carefully lower the scanner and press it down until it clicks into place.

6. If the document table glass gets dirty, clean it with a soft, dry, lint-free cloth. 
Paper towels are not recommended for cleaning the glass. (Be sure there’s no dust 
on your document table; it can cause white spots to appear in your scanned 
image.)

If the glass is stained with grease or other hard-to-remove material, use a small 
amount of glass cleaner on a soft cloth to remove it. Wipe off any remaining 
liquid with a dry cloth. Don’t spray glass cleaner onto the document table glass.

Warning: Don’t touch the gears inside the EPSON Stylus CX3200.

Don’t touch 
the metal 
carriage shaft
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Caution: Be careful not to wipe the metal carriage shaft.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can 
damage the printer components, document table, LCD panel, and case. 

Don’t get water on the components and don’t spray lubricants or oils inside the 
EPSON Stylus CX3200. 

Don’t spray glass cleaner onto the document table glass.

Don’t use any cleaning sheets included with special paper; they may jam inside 
the EPSON Stylus CX3200. 

Transportation

If you move your EPSON Stylus CX3200 some distance, you need to prepare it for 
transportation in its original box or one of a similar size. 

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the EPSON Stylus CX3200. Never transport or store the Stylus 
CX3200 on its side or in a tilted or upside-down position.

1. Press the On button to turn on the EPSON Stylus CX3200 and wait until the 
scanner carriage moves to the home position (toward the left side) and the print 
head locks in the far right position, then turn it back off. 

2. Open the scanner lid and slide the transportation lock to the locked position.

3. Unplug the power cord from the electrical outlet. Then disconnect the USB cable.

4. Remove any paper from the sheet feeder and output tray, then remove the paper 
support and feeder guard.

5. Lift up the scanner. 
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6. If you still have the packing insert, slide it down into the area beside the ink 
cartridge holder and tape it to the EPSON Stylus CX3200 case. If you don’t have 
the insert, just tape the cartridge holder to the EPSON Stylus CX3200 case.

Caution: Be sure to remove the tape and packing insert after installing the 
EPSON Stylus CX3200 in its new location.

7. Close the scanner carefully until it clicks back into place, then close the output 
tray.

8. Repack the EPSON Stylus CX3200 and its attachments in the original box using 
the protective materials that came with them.

Keep the EPSON Stylus CX3200 level as you transport it. 

After transporting the EPSON Stylus CX3200, remove the tape securing the print 
head, unlock the transportation lock, and make a test copy. If you notice a decline in 
quality, clean the print head (see Cleaning the Print Head); if output is misaligned, 
align the print head (see Aligning the Print Head). 

Insert the packing 
material and tape the 
ink cartridge holder 
to the case
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EPSON Stylus CX3200 Parts

Diagnosing Problems

� Checking the Control Panel

� Printing a Nozzle Check

Checking the Control Panel

Paper support

Control panel

Scanner lid

Transportation lock

Document table Output tray

On button 
and light

Error light

B&W Copy buttonScan button

Color Copy button

Stop button
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Here is a list of control panel error messages and what you can do when you see them. 

Printing a Nozzle Check

You can print a nozzle check to determine whether a problem comes from the 
EPSON Stylus CX3200 or some other source. 

1. Make sure letter-size or larger paper is loaded in the sheet feeder.

2. Press a Menu button on the control panel until you see Nozzle Check. 

Error message Solution

No color or black ink cartridge – – >
Press the Color Copy button to install 
a new ink cartridge. 

The indicated ink cartridge is not installed. 
See Replacing an Ink Cartridge to install a 
cartridge. 

Color or black ink out – – >
Press the Color Copy button to begin 
replacing the ink cartridge.

The indicated ink cartridge is out of ink. See 
Replacing an Ink Cartridge to replace the 
cartridge. 

Ink cartridge error – – >
Press the Color Copy button to begin 
replacing the ink cartridge. 

There is something wrong with the ink 
cartridge. See Replacing an Ink Cartridge to 
replace the cartridge. 

Paper jam or misfeed – – >
Press the Color Copy button and clear 
the paper jam by hand if necessary. 

Paper is jammed. Press the Color Copy 
button to clear the jam. If it is still jammed, 
see Paper.

Paper out – – >
Load paper in the sheet feeder and 
press the Color Copy button.

Load paper in the sheet feeder, then press 
the Color Copy button to continue printing. 

Scanner unit open – – >
Close the scanner unit.

Carefully close the scanner and press it down 
until it clicks securely into place.

Scanner error – – >
See your documentation and call 
service if necessary.

Press the

 

 On button to turn off the EPSON 
Stylus CX3200. Unlock the transportation 
lock, if necessary (see Transportation). Turn 
on your Stylus CX3200 again. If the error 
message still appears, contact your dealer or 
EPSON as described in Where To Get Help.

Printer error – – >
See your documentation and call 
service if necessary. 

Press the On button to turn off the EPSON 
Stylus CX3200, then press it to turn it back 
on. If the message still appears, contact your 
dealer or EPSON as described in Where To 
Get Help. 
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3. Press the Color Copy button. 

If the check page prints, the problem probably lies in your software settings, the 
interface cable, or your computer. 

If the check page doesn’t print, you may have a problem with your printer. Try the 
suggestions in Problems and Solutions. 

Problems and Solutions

� Setup and Software Installation

� Printing and Copying

� Scanning

� Paper

� Print Quality

� Miscellaneous Printing

� Scan Quality

Setup and Software Installation

Tip: It’s a good idea to check EPSON’s web site periodically for possible updates 
to your software. Visit http://support.epson.com and check the section for your 
product to see if there is new software available for downloading to your 
computer. 

The EPSON Stylus CX3200 makes noise after ink cartridge installation. 

� When you install ink cartridges, the Stylus CX3200 must charge its ink delivery 
system. Wait until it’s finished (the On light stops flashing) before you turn it off 
or it may use excess ink the next time you turn it on. 

� Make sure the ink cartridge clamps are locked down and no packing material 
remains in the EPSON Stylus CX3200. Turn off the Stylus CX3200, wait a 
moment, then turn it back on.
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You cancelled software installation or connected the EPSON Stylus CX3200 at 
the wrong time. 

Your EPSON software may be incorrectly installed. See Uninstalling Software to 
uninstall your software. Make sure you carefully follow the steps on your Start Here 
sheet when you reinstall your software. You need to connect the Stylus CX3200 at the 
correct time. 

You’re having problems installing the software.

� Make sure your system meets the requirements listed in the Requirements and 
Notices booklet. Close other programs, including screen savers and virus 
protectors, and install again.

� Make sure that the Universal Serial Bus (USB) Controller is working properly in 
Device Manager; see your Windows help system for details. 

� If you see an error message or the software doesn’t install correctly on 
Windows XP or Windows 2000, you may not have software installation 
privileges. 

� If the CX3200 icon doesn’t appear in the Macintosh Chooser, you may have too 
many items in the Chooser. Delete any unused items.

� If you’re printing over a network, see Setting Up Network Printing for 
instructions on configuring your EPSON Stylus CX3200. 

Printing and Copying

Only the On light is on, but nothing prints.

� Make sure the USB cable is securely connected at both ends and meets the system 
requirements listed in the Requirements and Notices booklet.

� If you’re using a USB hub, try connecting the Stylus CX3200 directly to your 
computer’s USB port instead.

� Run a nozzle check as described in Printing a Nozzle Check. If the check page 
prints, make sure the EPSON Stylus CX3200 software is installed correctly on 
your computer. 

� If you’re printing on a network, you need to set up your EPSON Stylus CX3200 
for network printing, as described in Setting Up Network Printing. 
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It sounds like the EPSON Stylus CX3200 is printing, but nothing prints.

� The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions.

� The Stylus CX3200 won’t operate properly if it’s tilted. Place it on a flat, stable 
surface.

Your EPSON Stylus CX3200 makes noise when you turn it on.

Your EPSON Stylus CX3200 is performing routine maintenance. 

Printing or copying is too slow.

Make sure your system meets the requirements listed in the Requirements and Notices 
booklet. If you’re printing a high-resolution image, you need more than the 
minimum requirements. You may also need to:

� Clear space on your hard disk or run a defragmentation utility.

� Close open programs that you’re not using.

� Increase your system’s memory (RAM).

For the fastest printing:

� Select Draft as the Quality Type (Windows) or set the Quality/Speed slider to 
Speed (Macintosh) in your printer software.

� If your document doesn’t include color, choose Black Ink Only (Windows) or 
Black ink (Macintosh) in your printer software (see Basic Windows Printing, 
Printing With Macintosh OS 8.6 to 9.x, or Printing With Macintosh OS X), or 
press the B&W Copy button (see Changing Copy Settings).

� Turn MicroWeave® off (Macintosh) and High Speed on in your printer 
software.

� If your EPSON Stylus CX3200 is connected to a USB hub, disconnect any 
unused USB devices.

The margins are incorrect.

� Make sure your paper settings are correct for your paper size. See see Basic 
Windows Printing, Printing With Macintosh OS 8.6 to 9.x, or Printing With 
Macintosh OS X.
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� Choose the correct margins for your paper size. The margins must be within the 
printable area of the page; see Printable Area.

� Make sure your paper is positioned on the right side of the sheet feeder with the 
left edge guide lightly against its left side. Don’t load paper above the arrow on the 
left edge guide.

The printer prints blank pages.

� Make sure your paper settings are correct for your paper size. See see Basic 
Windows Printing, Printing With Macintosh OS 8.6 to 9.x, or Printing With 
Macintosh OS X.

� The print head nozzles may need cleaning; see Cleaning the Print Head for 
instructions. 

Scanning

Your system doesn’t recognize the EPSON Stylus CX3200.

Make sure your Stylus CX3200 is connected to your computer and plugged into a 
power source. 

The fluorescent lamp isn’t on.

� The EPSON Stylus CX3200 has a power saving function (sleep mode); it comes 
on when you start scanning.

� Make sure the EPSON Stylus CX3200 is plugged into a power outlet. 

The EPSON Stylus CX3200 doesn’t scan.

� Wait until the fluorescent lamp stays on (ready for scanning). You may need to 
preview your scan to make the lamp come on.

� If you are using a USB hub, try connecting the EPSON Stylus CX3200 directly 
to the computer’s USB port. Use only the USB cable that came with your Stylus 
CX3200.

� If you see your EPSON Stylus CX3200 in the Windows Control Panel, but you 
can’t scan, uninstall and reinstall its software; see Uninstalling Software.
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The EPSON Stylus CX3200 scanning software doesn’t work properly.

� Make sure your computer meets the system requirements listed in the 
Requirements and Notices booklet and supports the software applications you’re 
using.

� Check if your computer has enough memory for your software. If you’re running 
other software at the same time, the computer may not have enough memory. Try 
closing any open applications, including screen savers and virus protection 
programs. 

� If you’re scanning a large image or scanning at a high resolution, your computer 
may not have enough memory to process the image.

� Check your software installation. If all else fails, uninstall your software, then 
reinstall it; see Uninstalling Software.

� If you’re using the Scan button make sure Smart Panel and your operating 
system are set up for scanning using the button. Click the ? button on the Smart 
Panel main window for instructions.

Paper

Too many copies are printing.

Make sure that the Copies setting in your printer software and/or printing software 
aren’t set for multiple copies.

Paper doesn’t feed correctly or jams in the printer.

� If paper doesn’t feed, remove it from the sheet feeder. Fan the paper, load it 
against the right side, and slide the left edge guide lightly against it.

� If paper jams, turn off your printer, open the scanner, and remove any paper that’s 
inside, including any small pieces that may have torn off. Carefully reload paper 
and press the Color Copy button.

Paper doesn’t eject fully or is wrinkled.

� If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
Color Copy button to eject the paper, then select the correct paper size in your 
software.
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� If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new 
paper.

Print Quality

You see banding (light lines).

� Clean the print head; see Cleaning the Print Head for instructions.

� Select the correct Type (Windows) or Media Type (Macintosh) setting for the 
paper you loaded; see Selecting Your Media Type.

� Select a higher print quality and turn off High Speed mode; see Customizing 
Windows Print Settings or Customizing Macintosh Print Settings.

� Make sure the printable side of the paper is face up. 

� The ink cartridges may need replacing; see Replacing an Ink Cartridge. 

� Try using Automatic mode (Macintosh); see Printing With Macintosh OS 8.6 
to 9.x or Printing With Macintosh OS X.

� Align the print head; see Aligning the Print Head for instructions.
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Your printout is blurry or smeared.

� Make sure your paper isn’t damp, curled, or loaded face down (the printable side 
should be face up). Load new paper face up.

� Use a support sheet with special paper or try loading your paper one sheet at a 
time.

� Make sure your paper meets the specifications listed in Paper.

� Align the print head; see Aligning the Print Head for instructions.

� Use EPSON papers for proper saturation and absorption of genuine EPSON 
inks.

Your printout is faint or has gaps.

� Clean the print head; see Cleaning the Print Head for instructions.

� The ink cartridges may be old or low on ink; see Replacing an Ink Cartridge. 

� Select the correct Type (Windows) or Media Type (Macintosh) setting for your 
paper; see Selecting Your Media Type.



64

� Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, load 
new paper face up. 

Your printout is grainy.

� Use a higher quality paper or select a higher Quality Type (see Customizing 
Windows Print Settings) or Print Quality (see Customizing Macintosh Print 
Settings).

� Align the print head. See Aligning the Print Head for instructions.

� Increase the image resolution or print it in a smaller size; see your software 
documentation.

You see wrong or missing colors.

� Make sure Black Ink Only is off (Windows) or Color ink is selected (Macintosh), 
even when you’re printing black and white photographs.

� Clean the print head; see Cleaning the Print Head for instructions.

� The ink cartridges may be old or low on ink; see Replacing an Ink Cartridge. 

� Try turning off PhotoEnhance.™ Also check if you’re using a special effect that 
alters image colors, like Sepia.

� Try using Automatic mode (Macintosh); see Printing With Macintosh OS 8.6 
to 9.x or Printing With Macintosh OS X.

� Try changing the Gamma setting; see Customizing Windows Print Settings or 
Customizing Macintosh Print Settings.
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� Your printed colors can never exactly match your on-screen colors. However, you 
can use a color management system—such as ICM (Windows; see Customizing 
Windows Print Settings) or ColorSync (Macintosh; see Customizing Macintosh 
Print Settings) to get as close as possible. 

Miscellaneous Printing

You see incorrect characters.

� Make sure the USB cable is securely connected and that it meets the system 
requirements in the Requirements and Notices booklet. 

� Make sure your EPSON Stylus CX3200 is selected in your application, or as the 
Windows default printer. 

The image size or position is incorrect.

Make sure the paper and/or layout options are set correctly. Click the ? or Help 
button on your printer settings window for more information.

The image is inverted, as if viewed in a mirror.

� Turn off Flip Horizontal in the printer software or the mirror setting in your 
application software. (If you’re printing on EPSON Iron-On Transfer Paper, the 
image should be inverted so it looks correct when it’s ironed on.)

� If a copy is inverted, make sure Mirror isn’t selected as the Copy Mode setting; 
see Type of Copies.
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Scan Quality

Your scanned image is blurry or distorted.

� Make sure the document is placed flat against the document table glass. If only 
part of the image is blurred, your document may be wrinkled or warped.

� Try scanning at a higher resolution, and make sure the correct Image Type, 
Exposure, and Gamma setting is selected in EPSON TWAIN. Click the Help 
button on the EPSON TWAIN window for details.

� Make sure the document table glass is clean; see Cleaning the EPSON Stylus 
CX3200.

� Make sure the Stylus CX3200 is not tilted or placed on an unstable or uneven 
surface.

Your image is too dark.
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� Try adjusting the brightness with your application software. Also check the 
brightness and contrast values of your display screen.

� The dark area around film is perceived as white, altering the exposure of the 
scanning area and causing your scans to appear darker. Set the correct color by 
adjusting the border (marquee) so only your image is selected. Click Help in the 
EPSON TWAIN settings dialog box for details.

� Change the Display Gamma setting and check the Destination setting in EPSON 
TWAIN. Click Help in the EPSON TWAIN settings dialog box for details.

Only part of the image is scanned.

� The document table has non-readable areas around the edges. Reposition your 
document into the readable area, as described on Placing Your Original 
Document.

� If you’re using Full Auto Mode, try using Manual Mode. See Advanced Scanning 
for instructions.

The image does not look the same as the original.

� Your image and display settings may not be correct for your document type. Click 
Help in the EPSON TWAIN settings dialog box for details.

� Your monitor and printer use different technologies to represent colors, so your 
printed colors can’t match your screen colors exactly. Try increasing your 
monitor’s color palette to view a greater range of colors. 
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The scanner doesn’t recognize your image type when scanning in Full Auto 
mode.

Try scanning the image again. If that doesn’t work, scan in Manual mode. See 
Advanced Scanning for instructions. 

The file size is too big. 

Adjust your scan settings. Try selecting a lower resolution (dpi), saving the file in a 
different format, or scan only part of the image. 300 dpi is typically an adequate 
resolution for images that will be printed. 

The printed image is larger or smaller than the original size.

You have changed the resolution or scaled your image. The image size settings in your 
software determine the size of the printed image.

A dotted line appears in the image.

� If this happens on both your screen and printout, clean the document table as 
described on Cleaning the EPSON Stylus CX3200.

� If the line is just on your printout, you may need to clean your print head, see 
Cleaning the Print Head. 

Uninstalling Software

� Windows XP or 2000

� Windows Me or 98

Windows XP or 2000

1. Make sure your EPSON Stylus CX3200 is plugged in and connected to your 
computer.

2. In Windows XP, click Start, right-click My Computer, and click Properties. 

In Windows 2000, right-click My Computer and click Properties.
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3. Select the Hardware tab, then click Device Manager.

4. Click the plus (+) sign next to Imaging devices or Other devices. If a question 
(?) mark or an exclamation (!) mark appears next to the EPSON Stylus CX3200 
name, right-click the name, and then select Uninstall.

5. Disconnect the USB cable from the EPSON Stylus CX3200.

6. Click Start > Programs or All Programs > EPSON Smart Panel > Uninstall 
EPSON Smart Panel and follow the instructions on the screen.

7. When the Smart Panel uninstall is complete, click Start > Control Panel 
(Windows XP) or Start > Settings > Control Panel (Windows 2000). 
Double-click Add/Remove Programs. 

8. Choose EPSON Copy Utility, then click Add/Remove or Change/Remove 
and follow the instructions on the screen. Repeat this step to remove these 
programs too:

� EPSON User’s Guide

� EPSON Photo Print

� EPSON Printer Software

� EPSON TWAIN 5

� ScanToWeb

9. Follow the installation steps on the Start Here sheet to reinstall your software.
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Windows Me or 98 

1. Disconnect the USB cable from the EPSON Stylus CX3200.

2. Click Start > Programs > EPSON Smart Panel > Uninstall EPSON Smart 
Panel and follow the instructions on the screen.

3. Click Start > Settings > Control Panel. Double-click Add/Remove 
Programs. 

4. Choose EPSON Copy Utility, then click Add/Remove or Change/Remove 
and follow the instructions on the screen. Repeat this step to remove these 
programs too:

� EPSON User’s Guide

� EPSON Photo Print

� EPSON Printer Software

� EPSON TWAIN 5

� EPSON USB Printer Devices

� ScanToWeb

5. Follow the installation steps on the Start Here sheet to reinstall your software.
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Setting Up Network Printing

� Windows XP and 2000

� Windows Me and 98

� Macintosh

Windows XP and 2000

This section tells you how to set up the EPSON Stylus CX3200 so that other 
computers on the network can print to it.

Note: This section is for small network users only. If you are on a large network 
and would like to share the EPSON Stylus CX3200, consult your network 
administrator.

To install software programs in Windows 2000, it is necessary to log on as a user 
with administrative privileges (a user who belongs to the Administrators group).

To install software programs in Windows XP, it is necessary to log on with a 
Computer Administrator account. You cannot install software programs if you log 
on as a Limited account user. After you install Windows XP, the user account is 
set as a Computer Administrator account.

The images that are provided in the following section pertain to Windows 2000.

First, you need to set up the EPSON Stylus CX3200 as a shared printer on the 
computer to which it is connected. Then, you must add the EPSON Stylus CX3200 
to each computer that will access it through the network.

Setting Up a Shared Printer

To share the EPSON Stylus CX3200 with other computers on a network, follow the 
steps below to configure the computer to which it is connected.

1. For users of Windows 2000, click Start, point to Settings, and then click 
Printers.

For Windows XP users, double-click Printers and Faxes in Control Panel.

2. Right-click the icon for the EPSON Stylus CX3200, then click Sharing.
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3. Select Shared as (Windows 2000) or Share this printer (Windows XP), then 
type a name for the shared printer.

Note: Do not use spaces or hyphens in the shared printer name.

If you want Windows XP or 2000 to automatically download printer drivers to 
computers that are running different versions of Windows, click Additional 
Drivers and select the environment and the operating systems for the other 
computers. Click OK, then insert the printer software CD into the CD-ROM 
drive. Select the folder for Windows Me or 98. Click OK to install the additional 
drivers.

4. Click OK, or click Close if you installed additional drivers.

Accessing a Network Printer

To print to the EPSON Stylus CX3200 from other computers on a network, you 
must first add it to each computer that will access it. Follow the steps below.
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Note: The EPSON Stylus CX3200 must be set up as a shared resource on the 
computer to which it is directly connected before you can access it from another 
computer. For instructions, see Setting Up a Shared Printer.

1. For users of Windows 2000, click Start, point to Settings, and then click 
Printers.

For Windows XP users, double-click Printers and Faxes in Control Panel.

2. Double-click the Add Printer icon. The Add Printer Wizard opens.

3. Click Next. 

4. Select Network printer, then click Next.

5. On the next screen, click Next.

6. Double-click the icon of the computer that is directly connected to the EPSON 
Stylus CX3200. Then, click the icon for the EPSON Stylus CX3200.
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7. Click Next and follow the on-screen instructions.

Note: Depending on the operating system and the configuration of the computer 
to which the EPSON Stylus CX3200 is connected, the Add Printer Wizard may 
prompt you to install the printer driver from the printer software CD. In this case, 
click the Have Disk button and follow the on-screen instructions.

Windows Me and 98

This section tells you how to set up the EPSON Stylus CX3200 so that other 
computers on a network can print to it.

First, you need to set up the EPSON Stylus CX3200 as a shared printer on the 
computer to which this product is connected. Then, you must add the EPSON Stylus 
CX3200 to each computer that will access it through the network.

Note: This section describes how to use the EPSON Stylus CX3200 as a shared 
printer on a network. To connect it directly to a network without setting it up as a 
shared printer, consult your network administrator.

Setting Up a Shared Printer

To share the EPSON Stylus CX3200 with other computers on a network, follow the 
steps below to configure the computer to which it is connected.

1. Click Start, point to Settings, then click Control Panel.

2. Double-click the Network icon.

3. Click the File and Print Sharing button.

4. Select the I want to be able to allow others to print to my printer(s) check 
box and click OK.

5. In the Network dialog box, click OK.
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6. In the Control Panel, double-click the Printers icon.

Note: If a dialog box requesting the insertion of the Windows Me or 98 CD-ROM 
appears, insert the CD into the CD-ROM drive and follow the on-screen 
instructions.

If a dialog box requesting that you to restart your computer appears, do so. Then, 
open the Printers folder, and continue from step 7.

7. Select the icon for this product in the Printers folder, then click Sharing on the 
File menu.

8. Select Shared As, then type the information of this product as required and click 
OK.

Accessing a Networked Printer

To print to the EPSON Stylus CX3200 from other computers on a network, you 
must first add it to each computer that will access it. Follow the steps below.

Note: The EPSON Stylus CX3200 must be set up as a shared resource on the 
computer to which it is directly connected before you can access it from another 
computer. For instructions, see Setting Up a Shared Printer.

1. Click Start, point to Settings, and click Printers.



76

2. Double-click the Add Printer icon. The Add Printer Wizard opens.

3. Click Next.

4. Select Network printer, then click Next.

5. On the next screen, click Browse.

6. Double-click the icon of the computer that is directly connected to the EPSON 
Stylus CX3200. Then, click the icon for the EPSON Stylus CX3200.

7. Click OK and follow the on-screen instructions.
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Macintosh

This section tells you how to set up the EPSON Stylus CX3200 so that you can print 
to it on an AppleTalk network. By setting up the EPSON Stylus CX3200 as a shared 
printer, your local printer is connected to the network and can be used by other 
computers.

Note: This feature is not available with Mac OS X.

First, you need to set up the EPSON Stylus CX3200 as a shared printer on the 
computer to which it is connected. Then, you must specify the network path to the 
EPSON Stylus CX3200 from each computer that will use it, and install the printer 
software on those computers.

Setting Up a Shared Printer

To share the EPSON Stylus CX3200 with other computers on an AppleTalk 
network, follow the steps below to configure the computer to which it is connected.

1. Turn on the EPSON Stylus CX3200.

2. Choose Chooser from the Apple menu and click the icon for the EPSON Stylus 
CX3200. Then, select the port to which the EPSON Stylus CX3200 is 
connected.

3. Click the Setup button. The Printer Sharing Setup dialog box opens.

4. Select the Share this Printer check box, then type the printer name and 
password information as necessary.

5. Click OK. The name of the shared printer appears in the port list in the Chooser.

6. Close the Chooser.

Accessing a Networked Printer

To access the EPSON Stylus CX3200 from other computers on a network, follow the 
steps in this section for each computer that will access it.

1. Turn on the EPSON Stylus CX3200.

2. Install the printer software from the EPSON Stylus CX3200 CD-ROM.
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3. Choose Chooser from the Apple menu. Then, click the icon for the EPSON 
Stylus CX3200 and select the printer port that you want to use from the Select a 
printer port list.

Note: Only printers that are connected to your current AppleTalk zone are 
available.

4. If password dialog box appears, enter the password for the EPSON Stylus 
CX3200, then click OK.

5. Select the appropriate Background Printing radio button to turn background 
printing on or off.

6. Close the Chooser.

Where To Get Help

� EPSON

� Other Software Technical Support

EPSON

If you need help with the EPSON Stylus CX3200, Film Factory, EPSON TWAIN, 
or EPSON Scan to File, see the contact information below. See Other Software 
Technical Support if you need help with other software that came on your EPSON 
Stylus CX3200 CD-ROM.
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EPSON provides technical assistance 24 hours a day through the electronic support 
services and automated telephone services listed in the following table:

To speak to a technical support representative, dial:

� U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday

� Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday

Toll or long distance charges may apply.

Before you call, please have the following information ready:

� Product name (EPSON Stylus CX3200)

� Product serial number (located on the back)

� Proof of purchase (such as a store receipt) and date of purchase

� Computer configuration

� Description of the problem 

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON 
Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral. 

Service Access

World Wide 
Web

From the Internet, you can reach EPSON Support at 
http://support.epson.com. At this site, you can download drivers and 
other files, look at product documentation, access troubleshooting 
information, and receive technical advice through e-mail. 

Automated 
Telephone 
Services

A variety of automated help services are available 24 hours a day, seven 
days a week. To use these services, you must have a touch tone 
telephone and call (800) 922-8911. Your EPSON SoundAdviceSM 
Express Code is 70420. Use this code to quickly select the EPSON 
Stylus CX3200 in SoundAdvice.
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Other Software Technical Support

Software Telephone Fax Online and E-mail

EPSON Smart Panel (510) 445-8616 (510) 445-8601 tech@newsoftinc.com

ArcSoft 
PhotoImpression

(510) 440-9901
8:30 AM to 5:30 PM, 
Pacific Time, Monday 
through Friday

(510) 440-1270 www.arcsoft.com

support@arcsoft.com
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Specifications

� Printing

� Paper

� Mechanical

� Ink Cartridges

� Scanning

� Electrical

� Environmental

� Standards and Approvals

� Interface Specifications

Printing

Paper

Note: Since the quality of any particular brand or type of paper may be changed 
by the manufacturer at any time, EPSON cannot guarantee the quality of any 
non-EPSON brand or type of paper. Always test a sample of paper stock before 
purchasing large quantities or printing large jobs.

Printing method On-demand ink jet

Nozzle configuration Monochrome (black) 144 nozzles

Color (cyan, magenta, yellow), 144 nozzles (48 nozzles 
per color × 3)

Print direction Bidirectional with logic seeking

Control code ESC/P raster

EPSON Remote

Input buffer 64KB
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Single sheets

Envelopes

Ink Jet Cards

Size A4 (8.3 × 11.7 inches)

A5 (5.8 × 8.3 inches)

A6 (4.1 × 5.8 inches)

B5 (7.2 × 10.1 inches)

Letter (8.5 × 11 inches)

Half-letter (5.5 × 8.5 inches)

Legal (8.5 × 14 inches)

Executive (7.3 × 10.5 inches)

Paper type Plain bond paper, special paper distributed by EPSON

Thickness (for plain bond 
paper)

0.003 to 0.004 inch (0.08 to 0.11 mm)

Weight (for plain bond 
paper)

17 lb (64 g/m²) to 24 lb (90 g/m²)

Size 132 × 220 (5.2 × 8.7 inches)

No. 10 (4.1 × 9.5 inches) 

DL (4.3 × 8.7 inches) 

C6 (4.5 × 6.4 inches) 

Paper type Plain bond paper, air mail

Thickness 0.006 to 0.02 inch (0.16 to 0.52 mm)

Weight 12 lb (45 g/m²) to 20 lb (75 g/m²)

Size A6 (4.1 × 5.8 inches)

Paper type Special paper distributed by EPSON
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Iron-On Transfer Paper

Transparencies and Glossy Paper

Self Adhesive Sheets

Photo Paper and Glossy Photo Paper

Premium Glossy Photo Paper

Size Letter (8.5 × 11 inches)

Paper type Special paper distributed by EPSON

Size Letter (8.5 × 11 inches)

Paper type Special paper distributed by EPSON

Size A4 (8.3 × 11.7 inches)

Paper type Special paper distributed by EPSON

Size Letter (8.5 × 11 inches)

4 × 6 inches (101.6 × 152.4 mm)

A4 (8.3 × 11.7 inches)

Panoramic (8.3 × 23 inches)

Paper type Special paper distributed by EPSON

Size Letter (8.5 × 11 inches)

4 × 6 inches (101.6 × 152.4 mm)

5 × 7 inches (127 × 178 mm)

8 × 10 inches (203 × 254 mm)

Paper type Special paper distributed by EPSON
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Photo Stickers

Matte Paper Heavyweight and Double-Sided Matte

Note: Poor quality paper may reduce the print quality and cause paper jams or 
other problems. If you have print quality problems, switch to a higher grade 
paper.

Do not load curled or folded paper.

Use paper under normal conditions:

Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Store EPSON Photo Quality Self Adhesive Sheets under the following conditions:

Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Printable Area

Single sheets or cards

Size A6 (4.1 × 5.8 inches) with 16 frames

Paper type Special paper distributed by EPSON

Size Letter (8.5 × 11 inches)

8 × 10 inches (203 × 254 mm)

Paper type Special paper distributed by EPSON

A

B-L B-R

C

Normal BorderFree**
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Envelopes

Note: Always load paper into the sheet feeder with the short edge first. Load 
envelopes flap edge left with the flap side down.

A: The minimum top margin is 0.12” (3.0 mm).

B-L: The minimum left margin is 0.12” (3.0 mm).

B-R: The minimum right margin is 0.12” (3.0 mm).

C: The minimum bottom margin is 0.55” (14.0 mm).

* You can extend the minimum bottom margin to 0.12”, however print quality 
may decline in the expanded area. Before printing large jobs using an 
extended margin setting, print a single sheet to confirm printout quality.

** When printing with the BorderFree or Borderless feature, the print quality 
may drop in the top and bottom areas of the printout, or the area may be 
smeared.
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Mechanical

Ink Cartridges

Black Ink Cartridge (T040120)

Paper feed method Friction

Paper path Sheet feeder, rear entry

Sheet feeder capacity About 100 sheets at 17 lb (64 g/m²)

Dimensions Width: 18.7 inches (475 mm)

Depth: 15.3 inches (389 mm)

Height: 9.25 inches (235 mm)

Weight 16.5 lb (7.5 kg) without the ink cartridges

Color Black

Print capacity* 600 pages/A4 (ISO/IEC 10561 Letter Pattern at 360 dpi)

Temperature Storage: 

–4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)

Transit: 

–22 to 140 °F (–30 to 60 °C)

1 month at 104 °F (40 °C)

120 hours at 140 °F (60 °C)

Freezing:** 3.2 °F (–16 °C)

Dimensions Width: 1.1 inches (28.1 mm)

Depth: 2.6 inches (66.85 mm)

Height: 1.5 inches (38.5 mm)
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Color Ink Cartridge (T041020)

* The figure given is based upon continuous printing after ink cartridge replacement. The actual 
print capacity may vary, depending on how often you use the print head cleaning function and 
how often you turn this product on.

** Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution: EPSON recommends the use of original EPSON ink cartridges only. 
Other products not manufactured by EPSON may cause damage to this product 
not covered by EPSON's warranties.

Do not use an ink cartridge if the date on the package has expired.

Do not refill the ink cartridges. This product calculates the amount of ink 
remaining using an IC chip on the ink cartridge. Even if the cartridge is refilled, the 
amount of ink remaining will not be recalculated by the IC chip and the amount of 
ink available for use will not change.

Color Cyan, magenta, and yellow

Print capacity* 300 pages (A4, 360 dpi, 5% duty each color)

Temperature Storage: 

–4 to 104 °F (–20 to 40 °C) 

1 month at 104 °F (40 °C)

Transit: 

–22 to 140 °F (–30 to 60 °C) 

1 month at 104 °F (40 °C)

120 hours at 140 °F (60 °C)

Freezing:** –0.4 °F (–18 °C)

Dimensions Width: 1.7 inches (43.2 mm)

Depth: 2.6 inches (66.85 mm)

Height: 1.5 inches (38.5 mm)
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Scanning

Electrical

Note: Check the label on the back of this product for the voltage information.

Scanner type Flatbed color image scanner

Photoelectric device Color CCD line sensor

Effective pixels 5,100 × 7,020 pixels at 600 dpi, 100%

Document size 8.5 × 11.7” (216 × 297 mm)

Letter or A4 size (reading area selectable with software)

Scanning resolution 600 dpi (main)

1200 dpi (sub)

Output resolution 50 to 4800 dpi (adjustable in one-dpi increments), 7200 
dpi, and 9600 dpi

Color separation RGB color filters on CCD

Image data 16 bits per pixel per color internal
8 bits per pixel per color external

Gamma correction User defined 1 level

Interface USB

Light source White cold cathode fluorescent lamp

Reliability 30,000 cycles of carriage movements (main unit MCBF)

Lamp 10,000-hour life

Input voltage range 99 to 132V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 A

Power consumption Approx. 22 W (ISO10560 Letter pattern)

Approx. 6.5 W in sleep mode

Approx. 0.3 W in power-off mode
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Environmental

* Stored in shipping container

** Without condensation

Standards and Approvals

Interface Specifications

This product’s built-in USB interface is based on the standards specified in the 
Universal Serial Bus Specifications Revision 1.1 and the Universal Serial Bus Device 
Class Definition for Printing Devices Version 1.1. This interface has the following 
characteristics.

Temperature Operation: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 104 °F (–20 to 40 °C)

1 month at 104 °F (40 °C)

Transit:* –4 to 140 °F (–20 to 60 °C)

120 hours at 140 °F (60 °C)

Humidity Operation: 20 to 80% RH

Storage:*, ** 5 to 85% RH

Safety UL 1950

CSA C22.2 No.950

EMC FCC part 15 Subpart B class B

CSA C108.8 Class B

Standard Based on Universal Serial Bus Specifications Revision 1.1, 
Universal Serial Bus Device Class Definition for Printing 
Devices Version 1.1

Bit rate 12 Mbps (full speed device)

Data encoding NRZI

Adaptable connector USB Series B
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Recommended 
cable length

6.6 feet (2 meters)



Appendix

� Copyright Notice

� Trademarks

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, mechanical, 
photocopying, recording, or otherwise, without the prior written permission of 
SEIKO EPSON CORPORATION. The information contained herein is designed 
only for use with this EPSON product. EPSON is not responsible for any use of this 
information as applied to other equipment.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the 
purchaser of this product or third parties for damages, losses, costs, or expenses 
incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this 
product or unauthorized modifications, repairs, or alterations to this product, or 
(excluding the U.S.) failure to strictly comply with SEIKO EPSON 
CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems 
arising from the use of any options or any consumable products other than those 
designated as Original EPSON Products or EPSON Approved Products by SEIKO 
EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted 
Materials

Digital cameras, scanners, and ink jet printers, like conventional photocopiers and 
cameras, can be misused by improper copying or printing of copyrighted material. 
While some countries’ laws permit limited copying of copyrighted material in certain 
circumstances, those circumstances may not be as broad as some people assume. 
EPSON encourages each user to be responsible and respectful of the copyright laws 
when using digital cameras, scanners, and ink jet printers.
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Trademarks

EPSON and EPSON Photo Stickers are registered trademarks and EPSON Smart 
Panel is a trademark of SEIKO EPSON CORPORATION. 

PhotoEnhance is a trademark and EPSON Connection, EPSON Store, EPSON Print 
Lab, and SoundAdvice are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners. EPSON disclaims any and all 
rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or 
service.

Copyright © 2002 by Epson America, Inc. 8/02
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